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About This Particular Macintosh has been free since 1995, and we intend to keep it that
way. Our editors and staff are volunteers with “real” jobs who believe in the Macintosh
way of computing. We don’t make a profit, nor do we plan to. As such, we rely on
advertisers and readers like you to help us pay for our Web site and other expenses.
We’ve partnered with CafePress.com to bring you high-quality ATPM merchandise. For
each item you buy, $1 goes towards keeping the atpm.com server running. You can also
help support ATPM by buying from online retailers using the following links:
Amazon.com, ClubMac, MacMall, and MacWarehouse. If you’re going to buy from them
anyway, why not help us at the same time?
We also accept direct contributions using PayPal and Amazon’s Honor System. We suggest
$10 for students and $20 for individuals, but we greatly appreciate contributions of any
size.
Finally, we are accepting inquiries from interested sponsors and advertisers. We have a
variety of programs available to tailor to your needs. Please contact us at
advertise@atpm.com for more information.
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Welcome

Welcome
by Robert Paul Leitao, rleitao@atpm.com

Welcome to the April, 2003 issue of About This Particular Macintosh! This month the US
returns to daylight savings time. This means an extra hour of daylight, but we wish there
were more things to see. In particular, we’d like to see the details about Panther, Apple’s
next OS X upgrade. But Mac watchers will now have to wait until late June to take in the
announcements at Apple’s annual World Wide Developers Conference. WWDC is now
scheduled for June 23–27, 2003 at San Francisco’s Moscone Convention Center and has
been pre-billed as a Panther pre-release party. Speaking of annual Apple conferences…

Is It CREATE or Capitulate?
This summer’s traditional Macworld Expo has been renamed CREATE. The revamped show
will not feature a keynote address by Apple CEO Steve Jobs, nor will it have a consumer
product focus. The new show is being tailored to the interests of creative professionals
and will highlight Mac-based solutions for the creative markets.
Over the past few years the number of companies that have chosen to forego expensive
trade shows in favor of less costly marketing opportunities has continued to rise. Despite
the continuing growth in the Macintosh market, it has also become increasingly difficult
for Apple to maintain a product release schedule tuned to both summer and winter semiMacworld Expo shows.
Some consider this decision to be a capitulation that the Mac maintains a relatively small
market share and that the company cannot maintain consumer interest in two annual
shows. Others see it as evidence that the Macintosh market is growing in new ways and
that success will be found in providing more solutions to professionals and enterprise
customers. The results of this summer’s CREATE expo may reveal the truth.

iGore
Vice President John Nance Garner once declared, “The vice presidency isn’t worth a
pitcher of warm spit.” But former Vice President Al Gore’s eight years of vice-presidential
service may have been what earned him a seat on Apple’s board of directors. In March,
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Apple announced the appointment of private citizen Gore to the company’s board. Mr.
Gore is filling one of two new board seats, increasing the number of board positions from
five to seven. Another new outside director will be selected before the end of summer.

ATPM’s Spam Man
About This Particular Macintosh has been in continuous publication since early 1995.
We’ve had the privilege and honor of chronicling the Macintosh experience for our
readers from the days just before the Internet’s mass adoption by Macintosh users, to
today’s mass adoption of Unix-based Mac OS X and the resurgence of the Macintosh
platform in living rooms, schools, and businesses.
Over the years ATPM has been home to many bright and dedicated writers and editors
who have devoted time and talent to the continuing development of our monthly Internet
magazine. One constant through our years of change has been the work of Michael Tsai,
ATPM’s publisher.
Recently Michael stepped beyond the role of Internet publisher to create a practical
solution for a problem plaguing most Mac users—e-mail spam. Michael’s SpamSieve
product was favorably reviewed in the April 2003 issue of Macworld as an inexpensive and
effective solution to unsolicited junk e-mail hassles. We salute Michael’s efforts and
suggest that Mac users plagued with junk mail issues give the free demo of Michael’s
product a try.

Hail to the Vice Chief
We have one more vice to mention. The late Vice President Hubert Humphrey once said,
“The President has only 190 million bosses. The Vice President has 190 million and one.”
In our case, this quote might apply to one of ATPM’s most important yet least
acknowledged jobs—managing editor.
We take seriously the feedback from our readers and pay close attention to your questions
and comments. Last month Chris Turner stepped into the managing editor’s position,
ATPM’s number two chair. Chris views all of our readers as our number one constituency
and will be working closely with Michael on each month’s release.
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In the Dock
Just like your Mac OS X desktop, each issue of ATPM has its own favorite items in the
Dock, ready for easy reading. This month’s issue includes:

The Candy Apple: Ride ’Em, Cowboy!
In which we investigate why it’s bad to spill drinks on your laptop.

Networks In Action: Learning to Share With Others: Sharing Preferences
Overview
This articles covers the Sharing pane in the Mac OS X System Preferences. Mac OS X
supports a wide variety of network services, including Windows networking support and
an Internet sharing application. Pictures and real-world examples are included.

What’s Under The Hood: Got Vinyl? Converting LPs to CDs—Part 2
In his second installment, Bob Lewis shows you how to transfer your music from vinyl to
plastic…and leave the pops and hisses behind.

How To: Making Jaguar Adopt Orphaned Printers (Hopefully)
Having problems getting Jaguar and your printer to get along? You’re not alone. Sylvester
Roque tells us about his experiences and the solutions he found along the way.

Cartoon: Cortland
This month, Cortland welcomes Al Gore to the fold and messes around with some older
Macs.

Desktop Pictures: Hong Kong
This month’s desktop pictures were submitted by ATPM reader Janet Mobley. Janet is the
editor of the North Coast Mac Users Group, and she took these pictures on a trip to Hong
Kong and Macau.
ATPM 9.04
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Review: DriveTest 1.0
DriveTest claims to show you whether or not your hard drive can cope with your demands.
Eric Blair shows you whether or not DriveTest is the right tool for the job.

Review: NetNewsWire 1.0.1
Eric Blair puts NetNewsWire to the test to see if it really can change the way you view the
Web.

Review: Photo Mechanic 3
Gregory Tetrault evaluates this image-browsing and information-editing application and
compares it to iView MediaPro, which he reviewed last month.

Review: Secrets of the iPod, 2nd Edition (book)
Kirk McElhearn looks at this book that tells you how to get the most out of your iPod,
from the software and hardware to third-party accessories and how to use it as a Mac OS
X startup disk.

Review: Studio MX
Lee Bennett and Darryl Barney take a look at Macromedia’s new Studio MX—a reducedcost bundle of their most popular Web site production tools: Dreamweaver, Flash,
Fireworks, Freehand, and more.
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Switching to OS X
Having just read your column in ATPM, I want to send encouragement to make the
switch. It is much less traumatic and much easier to learn that I ever dreamed.
My switch came about because I got a new iMac for Christmas, so my situation is
somewhat different. We took my old B&W G3 into the store my husband bought the iMac
from, where my sales representative copied my G3 hard drive to the new iMac. So, I didn’t
have to deal with that, although I did burn CDs of everything I didn’t want to lose, just in
case.
When I got the new iMac home, it took me five minutes, literally, to be on the Web and
getting mail using OS X as my startup system. I am using OS X Mail and Apple’s Safari
Web browser, and find them stable and trouble-free, although Mail lacks a return receipt
feature that I would really like to have. In that five minutes, I imported all my bookmarks
and mail folders from Netscape 4.79 (which I had been using for e-mail) flawlessly. I have
found only one Web site that insisted it could only work with Netscape or IE. I do have IE 5
on my hard disk, just in case.
Because OS X and OS 9 can run simultaneously on the iMac, I always start up in OS X
(have now upgraded to 10.2.4). None of my software (PageMaker 7.0, Microsoft Office
98, FileMaker 4.0 are the biggies, with lots of other applications and fonts) is OS X native.
I was a little apprehensive, but all I have to do to open an OS 9 program is to double-click
on it just as if I had started up in 9. I have found a couple of programs (Roxio Toast Light,
for example) that simply won’t work unless I restart in 9, but they are few and far
between. I certainly learned only the basics, but that is all I needed to do! I will find out all
the niceties as I go along.
I am enjoying working in OS X and will upgrade my software as funds (i.e. birthday and
Christmas money) come available. BTW, all my USB peripherals (Epson C80 printer, Epson
1240U scanner, Nikon CoolPix 775 camera) also worked flawlessly as soon as I plugged
them in.
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This was absolutely the easiest switch from Mac computer to Mac computer or OS to OS
that I have ever made. And this is the best Mac computer (since 1986) that I have ever
had. Plus, it is really cool looking! I guess you could say that I am a happy camper!
—Saundra Curry

The 2003 “Stuff You Can’t Live Without” Awards
Thank you for this great article. It’s nice to have a little overview of must-have apps of
today, now that there is a continuous stream of new software released for the Mac that
appears to be stronger than ever before. I guess Mac OS X really started an avalanche of
new developers for Mac and, though it’s great to have plenty of options when it comes to
software for a specific task, it’s also getting more and more difficult to pick the best-ofbreed. Kudos on your choices!
—M.E.

Kudos
This site is amazing. There are many points being discussed for which I have been
searching for a long time, but it’s all here. A big thanks to all at ATPM!
A big thanks also to Matthew Glidden—your articles are really helpful. You must be a
good bloke!
—Tim Huish

Printer Sharing
I enjoyed the article about sharing printers among Macs on a network. I wonder if you
have any suggestions for a situation where two non-networked computers, one a Mac
and one a PC, need to share a USB-capable printer. I inquired about using a USB hub to
connect the lot of them together and was told “you can’t do that.”
Any information would be appreciated.
—Jack Ladwig
ATPM 9.04
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It is true that you cannot use a USB hub to do what you want. If you don’t mind manually switching between
computer A and B, you could use a USB switchbox, which is an inexpensive solution. The only other way to
share the printer would require the two computers to be networked. —Evan Trent

ADB Tablet on OS X
Is there a driver that allows an ADB Wacom tablet to work using Mac OS X? I have an
iMate, and the Wacom works fine on OS 9.
—Tom
I would recommend you try the new OS X iMate driver from Griffin. You will also need to download the
latest version of the Wacom drivers for OS X. With both of those installed, the Wacom drivers may recognize
the ADB tablet when plugged into the iMate. If not, perhaps one of our readers can suggest a
solution. —Evan Trent

Virtual PC Games
Is there any way to upgrade the video on Virtual PC 5 so that I can at least play a game like
Half Life? It will run the program, but it’s incredibly slow. Any suggestions would be
wonderful.
—Ache
No. The only way you can play games that require a video accelerator card is to drop back to VPC 2 or 3.
Those older versions support Voodoo (3dfx) accelerator cards. Read my VPC 4 review to find out why support
was dropped. —Gregory Tetrault

The Object of Programming
If you want another example of object-oriented programming in AppleScript, please check
out my BBEdit Disk Browser Suite and BBEditLib .
—Emmanuel
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Converting LPs to CDs
This article comes at just the right time, I’m getting more interested in the music side of
the computer now. On January 8, 2003, I made inquiries into Black Cat Systems for their
“audiocorder” software, of which I’m still thinking about, and, recently, a friend of mine
installed “SoundEdit 16” on my iMac. Now, I’ve got all this great information from you.
Like Tony the Tiger says, “I feel great.”
—Toni Seth
•••
Mr. Lewis has the beginnings of a great article set. I think he is wise in eliminating
discussion of really high-priced equipment and software. “Sticker shock” is definitely the
case with some programs I’ve reviewed. I can’t wait to see his review of Amadeus II. It
looks like the ideal program at an unbeatable price, especially if you are using an input
device other than Griffin’s iMic. Also, M-Audio now has a standalone version of the
Audiophile 24/96. For the price (about $199), you get a lot of features. I’m purchasing one
myself.
I hope Apple will increase the number of bits the Audio Manager can handle to at least 24
bits. There are advantages to recording your sound at the highest bit level and sampling
rate even if you must downsample to 16 bits and 44.1 kHz later. With the higher
parameters, you have more information to deal with if you must do noise control and
other forms of sound shaping. Thus, you are not as likely to lose information as when you
are editing at lower parameter levels.
On to the next episode!
—Maurice C. Barone

Building Customized Boot CDs
I’m wondering if there is an option for non-Apple CD-R owners using Toast. I tried, but the
CD would not boot.
—Mike Kraemer
ATPM 9.04
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Creating a CD with BootCD does not require an Apple burner. Disk Copy does seem, however, to need a
burner that is fully supported. Here is the process I used to burn a boot CD using Toast Titanium 5.2.
1. Launch Toast 5.2 and choose Mount Disc Image (Command-M).
2. Select the Disc Image created by BootCD. Toast will mount the image and a CD icon will appear on the
desktop.
3. From Toast, choose Other and select Mac Volume.
4. When the Toast window changes to Mac Volume, choose Select. Do not use drag and drop. It won’t work
this way.
5. In the dialog box that appears, choose the name of the CD that Toast mounted in Step 2.
6. Clear the checkbox that says Optimize-on-the-fly and check the box that says Bootable. This does not
seem to work if Optimize-on-the-fly is checked.
7. Burn the disc and be sure to choose Burn Disc and not Burn Session.
—Sylvester Roque
Copyright © 2003 the ATPM Staff, editor@atpm.com. We’d love to hear your thoughts about our
publication. We always welcome your comments, criticisms, suggestions, and praise. Or, if you
have an opinion or announcement about the Macintosh platform in general, that’s OK too. Send
your e-mail to editor@atpm.com. All mail becomes the property of ATPM.
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Candy Apple: Ride ’Em, Cowboy!

The Candy Apple
by Ellyn Ritterskamp, eritterskamp@atpm.com

Ride ’Em, Cowboy!
I’ve always been suspicious of extended warranties. My assumption was that if the
product was well made, I shouldn’t have to purchase what is essentially insurance against
defect. I made that argument at my last new car purchase. I said, “It’s a Honda. Either it’ll
break on the way home, or it won’t break.” Hard for them to argue that their product was
poorly made and might need more than the standard protection.
That reasoning does not apply to more portable consumer items, though, like laptop
computers. No matter how well made the product is, there’s a better chance of damage to
an item that can be dropped than one that is stationary, so users with lots of experience
with iBooks and PowerBooks have generally recommended AppleCare protection plans.
I’m not here to counter that recommendation, but I do have a proposal worth your
consideration. Even if you don’t follow up on it with your laptop, it may be of use for you
for some other item. It’s an insurance thing called an inland marine rider, and its purpose
is to insure things that can be moved. First an anecdote on why it’s a good thing, then the
details.
One of my co-workers had a second-generation iBook that he liked very much. He
watched movies on it and carried it around from place to place, and even let friends play
with it. Since he would never be this careless himself, he believes one of these friends
accidentally spilled a glass of iced tea on the keyboard. He didn’t know it was in there until
the monitor started frizzing.
He sent it to be looked at by certified Apple technicians, who opened up the keyboard
and pronounced it sticky. (We live in the American South. Tea is required to be heavily
sweetened here. Visitors bring intravenous insulin drips to cope.) The Apple techs were
the ones who suggested tea spillage. They said it was everywhere, and that cleaning
would run about $300. He was willing to pay this, until they called back and said the tea
spillage had also gotten into something that would require replacing the monitor. Now
the estimate was $900, and he said to hold the phone.
ATPM 9.04
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He debated ditching the unit and spending the $900 on a new iBook. On a whim, he
called his insurance agent, who had a year earlier talked him into an inland marine rider
on his homeowner’s insurance policy. It cost him $15 a year, and covered his silverware
and some stuff like that. His agent said if this was a portable computer, it was covered for
replacement cost. New iBooks with DVD players go for $1,300 now, and they sent a check
the next day. No questions.
I have to think of this as a success story for the beleaguered consumer. Again, I’m not
recommending that anyone get a rider and forego Apple’s Protection Plan. I will say,
though, that if I could get my insurance agent to commit to a rider that covered a laptop
like my friend’s did, I’d certainly think twice about that costly warranty.
Here’s the deal on the inland marine rider: one story says Lloyd’s of London was looking
for a way to insure items that had arrived by ship but then had to be transported over land
to their destination. This way they could charge even more for insuring them. This story
may be apocryphal. Another version has to do with cargo being transported on barges on
canals, so they came up with the idea of “floater” coverage. In its current form, the rider
covers items that are mobile or in transit. One good explanation of the guidelines can be
found at Ask Alice.
These riders can cover everything from specialized auto tools to quilts—I found a bunch of
quilting sites when I first googled this topic! These are one-of-a-kind items that must be
moved now and then, and this is an inexpensive way to insure them. Just like your laptop,
digital camera, and whatever other portable electronic equipment you have that should be
insured but isn’t. Remember that normal property insurance will cover most items within
100 feet of your house, but if they leave the house, you may need this additional rider.
Ask an insurance professional to find out what’s best for you, but now you have another
weapon in the arsenal against tea spillage and other acts of gooberism.
Onward.
Copyright © 2003 Ellyn Ritterskamp, eritterskamp@atpm.com.
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Networks in Action: Sharing Preferences

Networks in Action
by Matthew Glidden, mglidden@atpm.com

Learning to Share With Others: Sharing Preferences
Overview
Introduction
Mac OS X moved most of OS 9’s system functions (i.e., control panels) to the new System
Preferences application. Functions previously in control panels like Sharing Setup, TCP/IP,
and AppleTalk now reside in the Network and Sharing preference panes. Network controls
the interfaces (i.e., Ethernet and AirPort) and your Internet connection. Sharing adds
functionality like Internet sharing, Windows File Sharing, and others. This article covers the
Sharing preferences functions.

What to Do First
If you want to network with other Macs or Windows computers, do the hardware side
first. The software just sits there and looks dumb if there aren’t any wires connecting
computer A to computer B. Want to go wireless? Install an AirPort card (or AirPort-friendly
wireless card) in each computer.
This overview assumes you’ve already got the network hardware sorted out. If not, see
other network articles on ATPM.com or the Three Macs site.
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First Glance
Open System Preferences and select Sharing. Better yet, drag the Sharing icon to your
shortcut bar. You’ll probably need it later.

The Sharing preferences window.

Sharing shows your computer name and opens to the Services tab. Most of the action is in
the Services tab. We’ll start with Personal File Sharing and Windows File Sharing to get
your files moving around the network.
Personal File Sharing (PFS) handles Mac-to-Mac file sharing. Type the “afp” address (in my
example, afp://192.168.1.100/) into an Internet browser to browse the files as if they were
on your own Mac. You can’t access shared files from the same Mac, so only enable PFS if
you’re sharing files with other Macs.
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Windows File Sharing makes your files available to Windows network users. Check
Windows File Sharing (WFS) if you didn’t already, or select the name and push the Start
button. Once WFS is active, open “My Network Places” to see your Mac’s files on a
networked Windows computer.

My Mac appears under “My Network Places.”
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You can also map your Mac as a network drive. On the Windows computer, right-click on
the “My Computer” icon and select “Map Network Drive.” Enter your Mac’s WFS address
(in my example, \\192.168.2.2\sevans).

Mapping your Mac to a network drive.

For Mac OS 9, sharing files conveniently with Windows required extra software. Mac OS X
includes the SMB protocol, which shares files between Windows and Unix-based systems.
Using WFS means you’re using Samba. Note: your dance skills will not improve.

Note on Multiple IP Addresses
Sharing Preferences shows your Internet IP address in its examples, which might not be
your IP address for sharing files. My computer uses AirPort for the Internet connection,
with the address \\192.168.1.100 (shown in the example screenshots). However, I share
files to my home network using Ethernet. Its IP address is \\192.168.2.2, different from the
Internet IP address.
If you use two network addresses like I do, don’t try to use the Internet IP address for file
sharing and vice-versa. (Nothing “bad” will happen, it just won’t work.) If you use a single
IP address for both Internet and file sharing, you don’t need to worry about this.
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Other Items in the Services Tab
Remote Login lets you connect to your Mac from networked computers using ssh.
Enable this if you want to log in remotely from the command line.
FTP Access turns your Mac into an FTP server, providing file upload and download for any
network computer with an FTP program. Sign in with your user name and your file sharing
IP address (ftp://192.168.2.2/ in my example).

FTP access from the Windows command line.

Some programs use Remote Apple Events to communicate across the network. I’ve
never used this function, so I assume a program will tell you if it needs to use them.
Printer Sharing does just what it says—it makes your Mac’s printer available to the
network. Other Macs can add your printer from the Print Center application. Just select
Add and locate your printer by network type (AppleTalk, Rendezvous, etc.). Print to it as
you would a normal printer. You must install the printer software on the networked Mac
before using a shared printer.
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Firewall Preferences
Firewall software protects your network connection by restricting specific kinds of
incoming traffic. Select Start on the Firewall tab to prevent network users from accessing
the selected services. Home users probably won’t need this often, but Internet users can
use it to enhance security. See the Mac OS X help files for more information about
firewalls.

The Firewall preferences tab.
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Internet Preferences
Select Start to share your Internet connection with other computers on the network. Your
Mac turns into a DHCP server, looking for other computers and assigning them IP
addresses. Set the other computers to use DHCP (or “Get IP address automatically”) and
they’ll “see” your Mac and use its Internet connection.

The Internet preferences tab.

Note: On my Windows laptop, I sometimes have to switch the network connection from
DHCP to a manual IP address and back to DHCP before it works properly. It’s currently
unclear to me why this is necessary, but you should try it if you have problems.

Example Setup
I frequently move files from my work laptop to my Mac. When I bring the laptop home, I
connect its Ethernet port to my switch. While it’s starting up, I open the Sharing
preferences on my Mac. I start Windows File Sharing and share my Internet connection.
ATPM 9.04
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When the laptop finishes booting, I open My Network Places and confirm that my Mac
appears in the list. If it doesn’t, I check the laptop’s network connection, then mount my
Mac as a network drive. File movement is now a simple drag-and-drop from Windows
Explorer. I can also browse the Net from my laptop. If I had a network game on both
computers, I could set them up to play against each other. And so on.
Once I finish working with the laptop, I disconnect it and shut down the services from the
Sharing preferences. I repeat the process any time the laptop returns home. Mac OS X’s
network services make this kind of connection a snap after years of Mac-to-Windows
networking headaches.
Copyright © 2003 Matthew Glidden, mglidden@atpm.com. Matthew Glidden is the webmaster of
Threemacs.com, a guide to constructing and maintaining home and small-office Macintosh
networks. He can also tango and juggle, not necessarily at the same time.
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What’s Under the Hood: Got Vinyl?

What’s Under the Hood
by Robert C. Lewis, rlewis@atpm.com

Got Vinyl? LPs to CDs Part 2—Recording and Editing
Thank You
Before we get started with part two, I must take a moment to thank everyone for all the
great comments and suggestions sent to me. In all my years of writing articles, I have
never received so many accolades from my readers. Yet I would be wrong not to credit our
great copy editors at ATPM. They have the hardest task of taking my sometimes off-key
writing and making it fit into the magazine like a glove. Therefore, as you thank me, I
must in turn thank them. With that out of the way, let us move on to part two.

I Almost Cringed
Last month, after ATPM went to press, I purchased the February issue of a certain UK Mac
magazine that happened to also have an abridged article about converting LPs to CDs.
The hairs on the back of my neck stood straight up when I read the author’s assertion that
it was OK to use the microphone port to transfer music to your Mac. I also received one or
two comments from readers to this effect.
Again, I must emphasize that you should not use the microphone port for this purpose. It
is not well shielded, which means it can (and will) pick up any electrical noise that is
produced within your Mac. You want the signal you record to be as clean as possible. Part
one discussed devices you can use instead of the microphone port.

The Story So Far
Last month, I said that there were no FireWire audio input devices on the market, and I
was corrected by one of our readers. FireWire devices do indeed exist, but I found that
they cost close to $800. Digital video (DV) converter boxes and camcorders can also
double up for audio work. If you already own one of these devices, it may make sense for
you to try to use it, but that is beyond the scope of this article.
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The Right Software
For the rest of this article I will look at Amadeus II, Final Vinyl (in conjunction with iMic),
Spin Doctor, Peak LE, and Montage with Ray Gun Pro for recording and editing your
music. The steps I am about to take you through can also apply to importing from tapes
and other input sources.
Most of what I will discuss here applies to all of the previously mentioned programs. No
matter which program you decide to use, make sure you take the time to read the relevant
instruction manual. All of the aforementioned software comes with excellent
documentation.

Preparation
Make sure the drive you are going to record on has enough space for your recording. On
average, you will use about 10 MB for every minute of recording time. That adds up to
between 400 MB and 700 MB in disk space per full-length album.
Take the time to quit any unneeded applications that are open in the background. Do not
try to do any multitasking while recording or editing, as either process can be extremely
demanding on your CPU. Although Mac OS X is supposed to share CPU time among
applications, background processes can still eat crucial CPU time. OS X is good at avoiding
this situation, but not perfect.
You may also wish to purchase an album cleaning solution. Normally, these solutions
come with special wipes to use on your LPs. These solutions help to reduce unwanted
noise by removing dust, fingerprints, and static buildup. I use Gruv Glide II on all my
albums; it costs around $25 and can be found in any Guitar Center.
Before you start recording, open your application’s Preferences panel and set the input
source and the bit rate. If your program allows, try to record at 24-bit to achieve a higher
resolution. Set the sampling rate to 44.1 kHz. Ironically, only Amadeus II (the cheapest of
all the programs) has support for a 24-bit sample size. Bias hopes to eventually add such
support in a future release of Peak LE. Ideally, Apple would build a digital input port into
future Macs.
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Recording
If you have done any recording using a tape deck, you will feel right at home recording to
your Mac. Depending on the program, you will either work with one or two main
windows for the job. The first contains the control panel, which lets you record, play,
pause, fast-forward and rewind just like on a tape recorder. The other window contains
the Volume Units (VU) meters. These meters show the intensity of the left and right
channels of your recording.
Depending on the program, you may also find a pair of sliders for increasing or decreasing
the gain of each channel. This prevents your recording from red-lining and avoids
distortion. Programs that lack VU meters usually control the gain of the recording
automatically. I have worked with both modes of recording, and I prefer having control
over the VU meters so I can fine-tune what I record.

Amadeus II Record Window
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Most sound cards and devices come bundled with software that simulates a master sound
mixing board. My Audiophile 2496 came with such software; it lets me sample and adjust
the incoming signal before it reaches my recording program.

M-Audio Delta Control Panel

Once you have set all of the parameters to your taste, you are now ready to start
recording. Cue your needle to the beginning of the album; this can be done with your
tone arm lifter. My Stanton STR8–80 has an on/off switch for the turntable motor, which
means I can place the needle on the LP at the exact beginning.
Now, press the Record button on your Mac, drop the needle slowly onto the album or
start the motor and sit back as your Mac does the rest. Once you reach the end of the first
side of the album, flip it over and continue recording. Don’t worry about pressing your
program’s Pause button while doing this; you can delete the gap when you come to edit
your recording.
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Once side two of the album has finished playing, press Stop on the software control panel,
save your recording as an AIFF file, and give it a name. You will also be presented with a
window that shows you a 2D image of your recording, where you will do all your editing.

Editing
Now I will show you how to clean up your recording. I recommend that you make a copy
of the recording at this point; this way, if you do make some glaring irreversible mistake
you can revert to your original recording. Let us now look at how to use some of the
editing functions of the applications I mentioned earlier.

Amadeus II ($25)
The first thing to do is trim the beginning and end of your recording, and cut out the gap
created when you flipped the album. Highlight these sections with your mouse, being
careful not to cut into your recording, and select Clear from the Edit menu. Amadeus II lets
you magnify the image of your recording so that you can fine-tune your editing to the
nearest millisecond in length. Try to leave about a two-second gap both at the beginning
and between sides one and two.
All of the filters I will now discuss can be selected from the Effects menu.
Denoising

The Denoising filter is designed to suppress background noise. First, select a section of
your recording that contains only noise. The best place to look is a quiet point in the
recording. From the Filter menu, select Sample Noise. Amadeus will create a noise profile
of the selected portion. Then select the whole recording and choose Suppress Noise in the
dialog. Amadeus II will then go through the entire recording and filter out all background
noise based on the section you sampled earlier.
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Sometimes you may find that there is no ideal section in the recording to get a sample
from. In that case, you will have to use the White Noise function. This presents you with a
dialog window where you select the amount of filtering you wish to apply in decibels (db).
Start with a low number of -70db and slowly raise that setting until the desired noise
disappears. Go too high and you risk major degradation in your recording.

Amadeus II White Noise Window

You can customize the Denoising tool by selecting Options… in the Denoising sub-menu.
Those transferring tape to CD will find the extra options useful in eliminating tape hiss. In
this window, set the noise type at smooth, with Adaptive Filtering checked. Select Long
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FFT from the pop-up menu, and select a Sensitivity Enhancement between 30% and 70%
as advised by the author of the program. For more information on this, I urge you to read
the documentation that comes with Amadeus II.

Amadeus II Denoising Window
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Normalize

The Normalize filter is very useful for boosting the amplitude (loudness) of a recording that
was recorded at too low a level. When applied, the overall volume of your recording is
optimized so that its maximum possible amplitude is reached without any frequency
clipping. You can apply it either to both channels as a whole or to one at a time. You can
also experiment with the level you wish to apply.

Amadeus II Normalize Window
Sound Repair

The Repair filter helps to eliminate the cracks and pops in your recording. Remember how
I told you to note down the times at which you heard these noises? This is where these
times will come in handy. If you look at the window with the image of your recording, you
will see that it is marked off in time segments at the bottom.
Referring to your notes, scroll to the first time you heard a pop. Zoom in as far as you can
on that section of the recording. You may have to scroll around a bit before you find the
pop, but it will stand out like a sore thumb in the form of a spike shaped like a “V.” It may
appear in either or both channels. Highlight a small portion before and after the spike, not
exceeding 40–50 milliseconds either way. Then select Open Repair Center, click Repair,
and the pop is history.

ATPM 9.04

33

What’s Under the Hood: Got Vinyl?

You can also set the Repair Center to do the repairs automatically. To do this, you will have
to tinker with the sensitivity slider so that it catches all the pops. After you have fully
applied this filter I recommend that you play back your recording, to make sure you have
nailed each defect.

Amadeus II Repair Center

iMic with Final Vinyl ($35)
At first, I was skeptical of how well the iMic would perform. To test its abilities I recorded
the same album at 16-bit with Amadeus II and Peak LE through my Audiophile 2496, and
again with Final Vinyl through the iMic. To my delight, I found that the Final Vinyl
recording came out sounding almost as good as the recordings produced by the other two
programs. I am still of the opinion that using the digital sound card produced a better
sounding and clearer recording, but at $35 the iMic does offer an inexpensive way to do
the job.
With Final Vinyl, as with other programs, you can listen to audio input and adjust the
levels before you start recording. One feature unique to Final Vinyl however is the ability to
boost your signal, as a substitute for a phonograph pre-amp. I am surprised that this
feature is not found in other audio programs.
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Although Final Vinyl is excellent software for recording, its editing functions are not quite
up to scratch. I read the manual and tried to edit my recording, only to come away a bit
frustrated. The manual is not clear on how to use Final Vinyl to clean up your recording. It
lacks the required filters to clean up your recording, but it does include an 8-band
equalizer to tweak the different frequencies.

Final Vinyl
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Bear in mind that this is version 1.0 of Final Vinyl. In the ReadMe, Griffin Technology even
admits that they plan to add many more features in future updates. In the meantime you
can always use Amadeus II, Spin Doctor, or Montage with RayGun to do your editing.

Peak LE ($99)
Peak LE, like Final Vinyl, is a great tool for recording, but not for editing. As Photoshop
users rely on third party plug-ins to manipulate photos, Peak LE has third party plug-ins to
handle automatic pop and click removal. Peak does however include a pencil tool that you
can use to manually remove pops.
Under OS 9.x, Peak LE works with a filter program called RayGun by Arboretum Systems,
Inc. As I write, the only way you can use RayGun in OS X is within another program called
Montage, also by Arboretum. I spoke to Bias, and they told me that Arboretum is in the
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process of writing a plug-in version. For now, though, you will have to use Amadeus II,
Spin Doctor, or Montage with RayGun to benefit from automatic removal of clicks and
pops.

Peak LE
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CD Spin Doctor (Bundled with Toast w/Jam, $199)
Recording with CD Spin Doctor is straightforward, but I do recommend that you check
your sound levels beforehand. You can use the gain control to change the intensity of the
signal. The filters bundled with Spin Doctor do an excellent job of cleaning up audio from
your LPs or tapes. The Filter window can be broken down into three main sections: noise
and pop, realizer, and output level.

CD Spin Doctor

The noise filter eliminates unwanted hum and background noise while the pop filter
removes cracks and pops. Those working with tapes will find the noise filter most useful
for removing hiss. You control the intensity of these filters with a set of sliders. The best
way to eliminate hiss is by finding a point in your audio where it is most prevalent and
highlight that section. Then, move the noise filter slider to the right in small increments.
Each time you do so, press Play to hear how that section sounds. Once you have removed
the hiss to your liking, highlight the whole recording and click Apply.

ATPM 9.04

38

What’s Under the Hood: Got Vinyl?

The pop filter is used in the same way as the noise filter. To use this filter, you will have to
refer back to those notes you took while you were dubbing to keep track of where the
pops and clicks occurred. If you did not keep such a timesheet, then you will have to listen
to the entire recording to locate each flaw.
To remove a pop, go to the point where it occurred and magnify that section. As I
mentioned earlier, the pop will show up as a pronounced spike in the form of a “V.”
Highlight the exact section where the pop occurs. Using the slider, make changes just like
you did with the noise filter. Make sure you pre-listen to your changes until you get it just
right. In most cases, I was able to rid myself of almost every snap and pop on my album
with this filter.
I say almost because there was one glitch that I could not quite correct in Spin Doctor. The
flaw was more like a skip in the music, and attempts to remove it resulted in distortion
rather than restoration. I decided to switch back to Amadeus II and Montage with RayGun
Pro; both were able to identify and rectify this one glitch without missing a beat. Apart
from this one unusual defect, Spin Doctor does an excellent job in removing pops and
clicks from your recording.
Realizer attempts to enhance the sound of your music in much the same way as an
equalizer does. It has three bands you can adjust; as always, listen to any changes before
applying them. Finally, the output filter tries to compensate for changes in audio levels
resulting from the use of other filters.

Montage 1.0 with Ray Gun Pro ($269)
Montage is a fully-featured multimedia editor. It is the perfect blend for those looking for
a package that deals with audio, movie, and text editing. By itself, Montage costs $149.
Arboretum’s audio restoration filter Ray Gun Pro (RGP) costs an additional $149, and both
bundled together cost $269.
The PDF manual is well done. I ended up printing out about 70 to 100 pages of the
manual so that I did not have to go switch back and forth between reading and using the
program. Montage also comes with an excellent tutorial to help you dive right in.

ATPM 9.04

39

What’s Under the Hood: Got Vinyl?

Recording in Montage is straightforward. From the Record/Playback menu, select Audio
Capture…. From the resulting window you can adjust the gain of the left and right
channels. Once satisfied with the levels, press Record.

Montage Record Window
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Using RGP filters, you can clean up unwanted noise in your recording. To access RGP,
select Process from the menu, then in the Audio Effect sub-menu scroll to the bottom and
select Ray Gun Pro.

Montage Menu Selection for Ray Gun Pro
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Upon selecting RGP, your audio window will be placed into a RGP capsule. Scroll up to the
top of the RGP window and double-click on the dark tan bar. That will call up the RGP
filter window. RGP is composed of five modules that can be used separately or in any
combination. These filters include Pop, Rumble, Hum, Noise, and Enhancement.

Montage Audio File in Ray Gun Pro

Other features in this window include a Process/Bypass button and a menu with five
presets to get you started. The Process/Bypass button lets you turn the filters on and off so
you can hear how they are affecting your music. The presets include Slow Noise Dynamics,
Vinyl+60Hz+Mild Enhance, Rumble+White Noise+50HZ, Noisy Drums+Strong
Enhancement, and Mild Frequency Hiss. If you decide to make any changes in the presets,
the menu will change to User Preset. In the release current at press time, User Preset
settings cannot be saved. Future updates of Montage will include the ability to create and
save your own presets; Arboretum expect an update in the near future.
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Pop

True to its name, the Pop filter removes any unwanted pops and clicks you may have in
your recording. The intensity of the filter is controlled by a slider that goes from zero to
100%. In general, I found settings between 50–75% to be a good range to work with.
Anything above 75% will have a negative effect on the audio. The preset for vinyl is 50%.

Montage Pop Filter with Preset Menu
Rumble

Rumble is a problem unique to LPs. The Rumble filter is a low pass filter that is designed to
cut out everything below an adjustable frequency cutoff. It consists of a Low Cut and Peak
slider. The Low Cut slider controls frequencies of the low pass filter ranging from 5 to 100
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Hz, while the Peak slider adds tone to compensate for the loss of signal and ranges from 6 to +6 dB. The presets for vinyl are about 40 Hz for the Low Cut and -6 dB for the Peak
filter.

Montage Rumble Filter
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Hum

Hum is a 60 Hz hum (or buzz) caused by alternating current interference. The Hum filter is
composed of three sliders: Frequency ranging from 40 to 70 Hz, Fine ranging from -1 to
+1 Hz, and Sensitivity going from 0 to 100%. The presets for Vinyl are 60 Hz for
Frequency, 0 for Fine, and 20% for Sensitivity.

Montage Hum Filter
Noise

This particular filter is very similar to the Denoising filter found in Amadeus II. It acts as any
other audio compressor would to try to eliminate noise produced by tape hiss, computer
fans, and other types of sound that exist across the entire recording. Of all the filters, the
noise filter is the most complex. Arboretum goes on to recommend that you should use
either a good set of headphones or a high quality monitoring system when using this
filter.
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Due to the complexity of this filter, an extra menu is included with preset values. These
presets include, Vinyl (33/45 rpm), Vinyl (78 rpm), Tape (Type I Ferro), Tape (Type II
Chrome), F.M. Radio (USA), F.M. Radio (Europe), and White Noise. I suggest that first time
users try with the presets before experimenting with the sliders.

Montage Noise Filter

The Noise Filter is composed of four main sliders: Threshold, Attenuation, Attack, and
Decay. Threshold is the overall level at which noise reduction works best. The Attenuation
slider determines how much noise to pull from a signal; too much of this filter will begin
to clip the higher frequencies in your recording.
Last, the Attack and Decay sliders complement each other. These sliders control the on/off
switch speeds for the compressor, determining how fast to apply noise reduction once
levels pass the Threshold level (Attack) and how quickly to fade back (Decay).
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Apart from the four main sliders, there are Low, Medium, and High (dB) sliders that act as
a gain control to help compensate for the other sliders. Once again, go with one of the
presets before going on your own with this filter.
Finally, the Enhancement filter is a three-band equalizer used to adjust the Bass (dB), Treble
(dB), and Stereo (%). While the Bass and Treble adjust the gain of these frequencies, the
Stereo alters your sound by widening or narrowing the spatial recording without a change
in the overall volume.

Next Month
When I first started writing this article, I thought (Ha!) that I could cover this whole topic in
the space of one article. Boy, was I ever wrong. After three weeks of hard work, I have
finally completed what is now part two of this series.
Next month, I will look at how to break your recording up into individual tracks, organize
them into a playlist, and finally burn them to CD. I will also explain how to use iTunes to
convert your tracks to MP3 so you can download them onto your iPod. Sadly, that last part
will be mostly theory since I do not own, and cannot afford, an iPod. Sigh.
Copyright © 2003 Robert C. Lewis, rlewis@atpm.com. Robert is a Mac consultant.
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How To: Adopting Printers

How To
by Sylvester Roque, sroque@atpm.com

Making Jaguar Adopt Orphaned Printers (Hopefully)
When I first read the feature list for OS X, I almost shorted out the keyboard drooling. I
mean, improvements to multitasking, network support, memory management, and a host
of other features—what is not to like?
Despite the many great reasons to purchase OS X, I adopted a “wait and see” attitude,
until I could gauge OS X’s stability. No matter how much I wanted the new features,
without a stable operating system a computer is little more than a pile of silicon chips,
wires, and other sundry parts.
After purchasing OS X, several more months went by before it became my primary OS.
This time, the wait was not due to concerns over stability. In tests on my system, things
had gone remarkably well. The problem was difficulty printing. There was no OS X driver
available for my Epson Stylus Scan 2500 printer/copier/scanner. That was a big problem
because, with the exception of a few games, most of the work done on my Mac needs to
be printed. I know it is a refurbished printer, but it is a real workhorse and I have had it for
less than four years.
Well, since I use OS X every day, and print documents almost every day, it is safe to
conclude that I have solved my printing problems. Perhaps my experiences will help you as
you attempt to solve your problems. Let us look at the options in the same order that I
explored them. For me this also puts the options in order from least to most preferable.
For purposes of this article, I will assume that you have checked your printer
manufacturer’s list of available drivers recently. If you are running Jaguar and you have not
checked for an updated driver since 10.0, it is time to check again.
Initially, few of the applications that I used regularly were OS X–native. I spent most of my
time learning the new system. Any actual “work” that I did involved launching an OS 9
application in Classic. I usually booted directly into OS 9 to print.

ATPM 9.04

48

How To: Adopting Printers

This process worked well enough but I did not like it. Having to reboot the system was an
annoyance. Classic ran well when I needed it to, but I was in a hurry to move all of my
operations to OS X. Every minute that I spent running some form of OS 9 was time spent
that did not fully take advantage of the new features I wanted. Solving my orphaned
printer problem became very important.

A Little Carbon and a Little Cocoa
Over time, I have gradually upgraded my critical applications to OS X. During this process,
I had an interesting mix of Carbon and Cocoa applications in use. Because these
applications behave a little differently, the methods that I used to print from them were a
little different. Let us examine the difference between these two types of applications and
how it affects printing if you do not have an OS X printer driver. For purposes of our
discussion, let us simplify things a bit.
Most Carbon applications are capable of running under OS 9 or OS X. In essence, which
interface the user sees and the options they have access to depend upon the operating
system used to boot the machine. Users booting from OS 9 see the OS 9 environment and
the printer drivers installed there. Launching the same application under OS X produces
the OS X environment and its options. Photoshop 7 is an example of one application that
behaves in this way.
These applications are great if you have an orphaned printer. Under most circumstances it
is possible to complete your work under OS X and then reboot, launch the application,
and print under OS 9. Having to reboot is something of an annoyance and on some
systems is rather time consuming, but it is better than not printing at all.
Cocoa applications run exclusively under OS X. Launching these programs usually results in
some variation of the Aqua interface. Even if you have an OS 9 printer driver installed on
your system, you will not be able to access that driver from Cocoa applications. Using an
orphaned printer under these circumstances takes some thought. Let us look at the
options in order from least to most preferable.

ATPM 9.04

49

How To: Adopting Printers

Making OS X Adopt Orphaned Printers
One of the options that I tried involved looking for an OS 9 mate to the OS X application
that I wanted to use. Once I found a mate, I would do all of my work in the OS X
application and then boot into the OS 9 version of the same program to print. For
example, if I used the OS X version of GraphicConverter to create a file, I could use the OS
9 version of GraphicConverter to print the same file.
Usually the file types were compatible and the process worked, but as I mentioned earlier
I did not like it. Rebooting the system was only part of the problem. This solution means
wasting hard drive real estate by keeping two copies of an application around. If you use
some of the larger programs or have a large number of programs, this may mean losing a
significant amount of drive space. Obviously, this might be a concern depending upon the
capacity of your hard drive.
One variation on this technique involved saving the file in a common file format and
printing from within an application which is not a direct mate to the OS X application that
created the file. Suppose, for example, you have the OS X version of GraphicConverter, an
OS 9–only version of Photoshop, and an orphaned printer. One solution is to use OS X
version of GraphicConverter to save the file in a format that Photoshop can read. Printing
the file still requires a trip to OS 9.
The major downside to this technique is that you must be aware of the various file types
available to save the file in and which OS 9 program can read the resulting file to open
and print it. Additionally, saving the file in the wrong format may mean that some
formatting is lost.

No Programs in Common?
Right about now you are saying, “OK, smart guy, what do I do with an orphaned printer if
I want to print a file but can’t find a common file type to bridge the gap between the two
operating systems?” Well, I stumbled upon a solution to this problem recently on a
bulletin board.
One of the features that I like about OS X is the ability to create basic PDFs without the
need to have the full version of Adobe Acrobat. Now, Acrobat is almost a necessity for
creating complex PDFs, but for basic printing, here is a cheaper option. This trick relies on
PDF creation features built into the system software. To accomplish this task, while in OS X
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use the Print dialog to save the file as a PDF. The file can then be printed using Acrobat
Reader under OS 9. While I have not tested this method extensively, correspondence with
users who have used this method more than I have indicates that this is not a great
solution if you need very accurate graphic printing.

Finally a Member of the Family
Using any of the above techniques will mean that your orphaned printer is not quite a fullfledged member of the OS X family because the actual printing is accomplished under OS
9. There are some ways however in which orphaned printers can almost become full-time
productive members of the OS X community.
After a few months using a variety of the techniques discussed above, I was getting a little
frustrated. One day, out of sheer desperation, I searched the discussion board on the
Apple Web site. I also searched the boards at MacFixIt, OS X FAQ, and a few other sites
that I do not remember. Somewhere in all of that reading and posting I discovered that
some users had found a way to hack together the driver for a printer that was supported
by OS X to make the driver operate a printer that was not supported by OS X. Finally, there
was some hope.
A few days after my initial post, I got lucky on two fronts. First, I found the directions to
hack a driver that would work with my Stylus Scan 2500. Second, I found someone who
had completed the hack successfully and was willing to send me the driver that he was
using to operate his Stylus Scan 2500. This was quite a break for me because I was wary of
trying to hack the driver myself. I installed the driver, rebooted the system and lo and
behold it worked. Most of the printing features worked well. The only feature I seem to
have lost is the ability to check the remaining ink levels.
If you choose to go this route in your search for a driver, check discussion groups devoted
to your printer manufacturer. Sometimes what you find there will surprise you.
The hacked driver worked well and finally I no longer needed to use OS 9 to print. This
was great, but with the upgrade to Jaguar, presented me with an additional option and I
have been using this method since about October of 2002.
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My CUPS of Tea
With the official release of Jaguar in August of 2002, Apple included access to a printing
method commonly referred to by long-time Unix users as CUPS. Short for Common Unix
Printing System, CUPS is a cross-platform printing solution for all Unix environments. Since
OS X has a Unix core, it is possible to implement this feature on your beloved Mac.
I am still digesting some of the details about CUPS. If you are interested in more detail,
check out this overview.
Now despite the fact that I tinker with Macs a lot, I must confess to being a little afraid of
tinkering with Unix. Don’t get me wrong, I plan to learn at least the basics, just not right
now. What I needed was an easy, preferably GUI way to access this feature. Once again,
the Mac community has come to my rescue with a nifty piece of programming called
Gimp-Print. This piece of software uses a standard OS X installer program to install all
necessary files.
The current version of Gimp-Print is a file that is roughly 10 MB. Before you download the
current version of Gimp-Print check out this FAQ page. It contains, among other things,
answers to common questions about the program, a list of supported printers, and a link
to the download. The list of supported printers is organized by manufacturer. If your
printer model is not listed, scroll toward the bottom of the list of supported printers. The
manufacturer’s names are repeated with a list of additional printers that are partially
supported. Most of the major manufacturers have at least some of their models on one of
these two lists.
Initially some users had reported that print jobs sent to Carbon applications such as
AppleWorks or Photoshop failed, while printing to the same printer from Cocoa
applications such as TextEdit was successful. This is usually due to an incomplete
installation that was performed manually. This issue is usually resolved if the pre-built OS X
installer package is used.
In testing using my Epson Stylus Scan 2500 I have found this software to yield results
virtually identical to the OS 9 driver that I was forced to use. It has proven to be an easy to
install and remarkably stable option. The other thing that I like about this option is that a
few mouse clicks lets configure my iBook for use with a different printer without installing
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a completely new set of software. In fact, over the Christmas 2002 holiday I began using
this driver with my wife’s Epson C80. A quick trip to Print Center allows me to choose a
printer.
The only flaw that I have experienced so far with this system is that I do not have the
ability to check remaining ink levels on the 2500. On the C80 I can, because when I
removed the somewhat ornery Epson C80 driver, I left the utility that checks ink levels
behind.
•••
I hope that at least one of these ideas will help you breathe new life into a previously
orphaned printer. It is at least worth a try before purchasing new equipment.
Copyright © 2003 Sylvester Roque, sroque@atpm.com. Sylvester Roque is a long-time Mac user who
currently works as a speech-language therapist in the public school system. His hobbies include
finding new uses for old Macs and listening to great blues.
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Cartoon: Cortland
by Matt Johnson, mjohnson@atpm.com
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Copyright © 2003 Matt Johnson, mjohnson@atpm.com.
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Extras: Desktop Pictures
Hong Kong
Hong Kong
This month’s desktop pictures were submitted by ATPM reader Janet Mobley. Janet is the
editor of the North Coast Mac Users Group, and she took these pictures on a trip to Hong
Kong and Macau.

Previous Months’ Desktop Pictures
Pictures from previous months are listed in the desktop pictures archives.

Downloading all the Pictures at Once
iCab and Interarchy (formerly Anarchie) can download an entire set of desktop pictures at
once. In iCab, use the Download command to download “Get all files in same path.” In
Interarchy, use HTTP Mirror feature.

Contributing Your Own Desktop Pictures
If you have a picture, whether a small series or just one fabulous or funny shot, feel free to
send it to editor@atpm.com and we’ll consider publishing it in next month’s issue. Have a
regular print but no scanner? Don’t worry. E-mail us, and we tell you where to send it so
we can scan it for you. Note that we cannot return the original print, so send us a copy.

Placing Desktop Pictures
Mac OS X 10.1.x and 10.2.x

Choose “System Preferences…” from the Apple menu and click the Desktop button. With
the popup menu, select the desktop pictures folder you want to use.
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You can also use the pictures with Mac OS X’s built-in screen saver. Choose “System
Preferences…” from the Apple menu. Click the Screen Saver (10.1.x) or Screen Effects
(10.2.x) button. Then click on Custom Slide Show in the list of screen savers. If you put the
ATPM pictures in your Pictures folder, you’re all set. Otherwise, click Configure to tell the
screen saver which pictures to use.
Mac OS X 10.0.x

Switch to the Finder. Choose “Preferences…” from the “Finder” menu. Click on the
“Select Picture…” button on the right. In the Open Panel, select the desktop picture you
want to use. The panel defaults to your “~/Library/Desktop Pictures” folder. Close the
“Finder Preferences” window when you are done.
Mac OS 8.5–9.x

Go to the Appearance control panel. Click on the “Desktop” tab at the top of the
window. Press the “Place Picture...” button in the bottom right corner, then select the
desired image. By default, it will show you the images in the “Desktop Pictures” subfolder
of your “Appearance” folder in the System Folder, however you can select images from
anywhere on your hard disk.
After you select the desired image file and press “Choose,” a preview will appear in the
Appearance window. The “Position Automatically” selection is usually fine. You can play
with the settings to see if you like the others better. You will see the result in the little
preview screen.
Once you are satisfied with the selection, click on “Set Desktop” in the lower right corner
of the window. That’s it! Should you ever want to get rid of it, just go to the desktop
settings again and press “Remove Picture.”
Mac OS 8.0 and 8.1

Go to the “Desktop Patterns” control panel. Click on “Desktop Pictures” in the list on the
left of the window, and follow steps similar to the ones above.
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Random Desktop Pictures

If you drag a folder of pictures onto the miniature desktop in the Appearance or Desktop
Pictures control panel, your Mac will choose one from the folder at random when it starts
up.
DeskPicture

An alternative to Mac OS’s Appearance control panel is Pierce Software’s DeskPicture,
reviewed in issue 5.10 and available for download.
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Review: DriveTest 1.0
by Eric Blair, eblair@atpm.com

Developer: FWB Software
Price: $24.95
Requirements: Mac OS 8.6 with CarbonLib 1.6 or Mac OS X
Trial: Fully-featured (no time limit)

One of the things that Apple wants people to know is that a megahertz
rating is not the only thing that determines the overall performance of a computer.
Oftentimes, the speed of a hard drive greatly affects how fast your computer can work—a
slow drive can prevent your computer from quickly accessing the data it needs to
continue. Furthermore, different tasks access hard drives in different ways. If you need
maximum performance out of your computer, then you need to find the proper hard
drive. FWB DriveTest is designed to help you find a hard drive that suits your needs.
DriveTest does two things: it benchmarks your hard drive and tests the validity of reading
and writing to your drive.
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Main Interface
For some reason, DriveTest’s main interface reminds me of Toast Titanium 5. I think it’s
probably because of the curved lines surrounding the interface.

Unlike Toast, though, the DriveTest interface feels very unfinished. One of the Mac’s
greatest strengths is in maintaining a consistent user interface between applications.
DriveTest is already starting on the back foot by making their application harder to learn.
The buttons are very un-Mac-like. When you click a button, there no visual indication that
the button is depressed. Since the buttons are drawn above the surface with a drop
shadow, it only seems logical that they would depress when clicked.
Also, the buttons trigger their action as soon as you click on them, not when you release
the mouse button. Every well-designed Macintosh application I can think of waits until the
user releases the mouse button before triggering an action.
DriveTest violates another user interface standard by reassigning the keyboard shortcut
Command-? to the “About Drive Tools‚” menu item. Again, every other well-designed
application uses this for the Help command, if one is present. DriveTest does indeed have a
Help command, but it has no keyboard shortcut. Also, according to Apple’s guidelines, the
name of the Help command should be “DriveTest Help,” not “Show Help.”
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DriveTest also falls victim to the same window closing bug as SMART Toolkit: the close box
is active even though the option in grayed out in the File menu. Once again, if you close
the window, you must relaunch the application.
Finally, there is a blank menu to the right of the Help menu. Its presence doesn’t hurt
anything, but it should not be there.

Benchmark
Benchmark runs a series of four tests on your hard drive: Sustained Read, Sustained Write,
Random Read, and Random Write. Together, the tests measure the effects of a drive’s
transfer rate, cache size, rotational latency, and seek time. The results can be displayed as
either a bar graph, a line graph, or a table of results.

Comparing an 800 MHz PowerBook G4 to a 667 MHz PowerBook G4 and a Dual 1 GHz
Power Macintosh G4.
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You can export your results as either a JPEG file or a text file. The JPEG option saves
whichever data you happen to be viewing at a given time, while the text option attempts
to recreate the raw data tables for each of the four tests.
After using the text export feature, I feel that it has two major shortcomings. First, while
the four benchmarking tests use data sizes ranging from 2K to 16 MB, the text export fails
to export any results for the 8 and 16 MB tests. If you want to preserve these results, or
just share them with others, you’ll need to add these data points by hand.
Second, the resulting text file is poorly formatted. On export, a tab is placed between each
data point and table heading. Unfortunately, each entry is necessarily the same
width—the test size column ranges between 2 and 4 characters and the drive names are
far longer than any other entry. On the one hand, the file imports nicely into Excel as a
tab-delimited file. On the other hand, you need to add the necessary tabs or spaces by
hand to make the file easily readable in a text editor. Since a text editor ships with every
copy of the Mac OS and Excel doesn’t, DriveTest’s text export feature should create files
that anybody can easily read.

An example of a poorly-generated text file from DriveTest.

If you want to keep your data in DriveTest for comparison with other drives, you can save
your results as a DriveTest file. This saves the name of the drive, the test results, any notes
you’ve entered about the drive, and the drive icon. In the future, you can view the results
against other drives that you test.
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For some reason, both Save and Export exist as buttons in the Benchmark window but not
in the File menu. At the very least, Save should be available there with a keyboard shortcut
of Command-S.
DriveTest also includes results for 15 test machines that you can use as a comparison for
your own hard drive. These comparisons continue the trend of strange design decisions
throughout DriveTest.
Each comparison machine has an icon associated with it, similar to drives you have tested
and saved. Unlike your saved drives, though, the icons don’t represent the drive tested.
Instead, they often represent the computer tested. Sometimes, the icons are faithful to the
original design of the computer. Other times, they seem to be artistic modifications of the
original computer. Finally, some icons make no attempt at representing the computer—I
fail to see why a hard drive with what appear to be a cracked casing represents a Power
Macintosh G4.

Some of the drive icons included with FWB’s sample results.

It’s possible that the people responsible for generating these tests were actually using
these as drive icons, but they were poor choices for a commercial product. When you
combine this with the occasionally confusing naming scheme used with sample results, it
can be difficult to determine what computer is represented by the results. I wasn’t able to
ascertain the model of at least two of the included results without going to the Apple
History Web site.
Finally, the included test results are getting a bit dated—I believe every product line they
include has been updated at least once since DriveTest was released. According to
DriveTest’s documentation, “Update test results will be posted on line as soon as they
become available.” However, products like the original “mirrored drive door” Power Mac
G4 were released and discontinued without DriveTest seeing any updates from FWB.
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Verifying
In many ways, DriveTest’s Verify feature is the opposite of the Benchmark feature. While
Benchmark tests a number of drive conditions very quickly, Verify focuses on a single case
for an extended period of time—Verify lets you see whether or not a drive can sustain its
performance over time.
There are four types of verification tests. Raw Read Speed and Raw Write Speed focus on
how quickly your drive can accept and retrieve data, respectively. Raw Throughput tests
both reading and writing speed. CRC Checksum Verified also tests both reading and
writing speed, but it also checks if any data corruption has occurred.
For each test, you set the duration and the block size. The test duration can range from
one minute to one day and the block size ranges from 2K to 16 MB. Typically, you base
these selections on how the drive will be used. For instance, a hard drive that is constantly
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streaming Digital Video should be tested with both a long test duration and a large block
size while a hard drive used for a low-volume e-mail server would probably call for a
shorter duration test with smaller block sizes.

Verifying a hard drive with the CRC Checksum Verified Test.

Conclusion
DriveTest claims to benchmark and verify your hard drives. It accomplishes this. However,
its interface is definitely lacking. Fortunately, DriveTest has a very liberal demo version, so
you can decide for yourself if its functionality makes up for its problematic interface.
Copyright © 2003 Eric Blair, eblair@atpm.com. Reviewing in ATPM is open to anyone. If you’re
interested, write to us at reviews@atpm.com.
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Review: NetNewsWire 1.0.1
by Eric Blair, eblair@atpm.com

Developer: Ranchero Software
Price: $39.95; free (Lite version)
Requirements: Mac OS X 10.2
Trial: Fully-featured (30 days)

A few months back, Michael Tsai introduced many ATPM readers to
Really Simple Syndication (RSS) and NetNewsWire Lite. The RSS format defines a specific
set of rules for describing the content of a Web site. Although an RSS feed can look rather
intimidating at first, an aggregator like NetNewsWire can easily parse the contents of the
feed and generate a summary of the Web site.
That’s all sounds nice and good, but what does it mean for the average user? After you set
up your RSS subscriptions in NetNewsWire, it periodically checks for new articles,
downloads them, and displays them in an easy-to-read format. As a result, you can always
see the most up-to-date articles from your favorite Web sites without spending countless
hours typing in URLs.
Since Michael’s article first appeared, Ranchero Software has released the full version of
NetNewsWire, which includes some advanced news reading features, a Weblog editor, a
Notepad, and AppleScript support. This review will focus on the full version of
NetNewsWire, but will also note some of the differences between the two versions.

ATPM 9.04

68

Review: NetNewsWire 1.0.1

News Reading
NetNewsWire uses a three-pane interface, similar to many e-mail applications. The left
pane shows all of your subscriptions, the top right pane shows the headlines for the
selected feed, and the bottom right pane shows the content associated with the headline.

NetNewsWire’s three-pane interface.

The similarities don’t end there; you can check for updates to your subscriptions manually
or at regularly scheduled intervals.
When NetNewsWire downloads new headlines, it displays the number of unread articles
in the dock and highlights any feeds with unread articles. By default, feeds with less than
ten unread articles are highlighted in bold blue. Feeds with ten or more unread articles are
shown as emboldened red. You can also choose to have the number of unread articles per
feed shown in the Subscriptions pane.
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For the times when you know you saw an article on a specific subject but can’t remember
where, NetNewsWire has a Find feature. It works mostly like you would expect,
highlighting the next article that contains the search term. Unfortunately, the search term
is not highlighted in the article itself, so you might have to skim through longer articles to
find it.

Subscribing to Feeds
NetNewsWire offers several ways to subscribe to news feeds. The first is the Subscribe
command, which displays a sheet that asks for the RSS URL for the new feed. If you know
the full address to the RSS feed, you can enter it here. Otherwise, you can just enter the
address for the Web site’s home page and NetNewsWire will try to find the site’s feed
based on some standard naming conventions.
If you’re using a Web browser and see a page you want to subscribe to in NetNewsWire,
you can use the “Subscribe in NetNewsWire” item in the Services submenu. This seems to
use the same RSS Discovery feature as the aforementioned Subscribe option.
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A more interesting approach to subscriptions is the Sites Drawer. The Sites Drawer links to
a very large number of RSS feeds, broken down into categories such as Fun, Macintosh,
and Science. There are also categories for different languages. Personal Weblogs are
divided up alphabetically. The bottom of the Sites Drawer contains a brief description of
the selected feed.

NetNewsWire’s Sites Drawer.

Looking for a single site in the Sites Drawer can be a bit daunting, but it can also yield
unexpected surprises. About a month or so ago, I was looking for something in the
Weblogs categories when I stumbled across the Weblog of an old college friend. Prior to
this, I hadn’t even realized he was running a Weblog.
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Weblog Editing
One of NetNewsWire’s main attractions is that you can use it for editing your own
Weblog. NetNewsWire supports most, if not all, of the major Weblogging packages, so
there’s a good chance it will work with whatever system you are using. If you use a
different system, you might still be able to use NetNewsWire with your Weblog,
depending on what interfaces your system supports.
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You can edit as many Weblogs with NetNewsWire as you want. In the Preferences, you tell
NetNewsWire where your Weblogs are located and supply any necessary information for
accessing their content. You can also set some preferences for how you want your posts
formatted.

Adding a Weblog to NetNewsWire.
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NetNewsWire’s Weblog Editor gives you the same basic editing options for each of the
supported Weblog systems. You can type the body of your entry, save it to your hard drive
as a draft, preview the post, and post it to your Weblog. You can also edit previously
posted entries.

Editing an Weblog entry in NetNewsWire.

Different Weblog systems support somewhat different features, so the interface of the
Weblog Editor is slightly altered depending on the configuration of the selected Weblog. If
you are using a system that supports titles for entries, the title field will show. For systems
that support URLs associated with entries, the URL field is activated. For systems that
support categories, there will be two ways to select categories.
The Weblog editor has some very basic HTML features. It has buttons for bold and
italicized text and a button to create hyperlinks. You can also add custom HTML tags to a
pop-up menu, and you can of course write your own HTML in the entry body instead.
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Personally, I only use the Weblog editor for short, simple entries. If I’m writing something
longer or something that contains HTML code or entities, I’ll do my writing in BBEdit first
so I can easily validate my code before posting.
One of NetNewsWire’s nicer touches is the Post to Weblog option. If you see an
interesting article from another RSS feed, choosing Post to Weblog will create a new entry
in the Weblog Editor. This new entry contains the originally selected article and a link to
the source.
I just wish I could customize this feature. When I cite another source, I like to put the
citation and link at the top of the article and block quote the original text. I can certainly
do this by hand, but it would be great if I could edit a Post to Weblog template and have
this happen automatically. This would give me one more reason to do my editing in
NetNewsWire.
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Notepad
NetNewsWire’s Notepad is a lightweight outliner for keeping track of whatever you want.
Typically, I use it to jot down notes about topics I’d like to post on when I have more time.

The NetNewsWire Notepad.

Since you can’t have multiple Notepads or do things like printing your outline,
NetNewsWire will not replace a fully-featured outliner like OmniOutliner. However, it
handles most of the basic outlining tasks and has one feature I believe OmniOutliner is
lacking: linking.
If you drag a file to the Notepad, a Notepad entry with an icon is created. Double-clicking
the icon opens the file. You can also drag entries from the Address Book to the Notepad
to get a vCard for the appropriate person, or link to URLs by dragging them over from a
Web browser. If you decide that an item needs a link at a later date, you can assign one
from the Attachment Info inspector.
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Unfortunately, the Notepad doesn’t auto-detect links in entries. For instance, dragging a
URL from BBEdit just inserts the text. If you want to link to the specified Web site, you
must add the link by hand.

Full versus Lite
If you’re interested in reading syndicated versions of your favorite Web sites in lieu of
trekking all over the Internet to see if they’re been updated, but don’t need
NetNewsWire’s Weblog Editing or Notepad features, you should look into its freeware
sibling, NetNewsWire Lite. It supports most of NetNewsWire’s features, with the following
exceptions:
•
•
•
•
•
•

No Weblog Editor;
No Notepad support;
You must be connected to the Internet to read feeds;
Headlines don’t show dates, subjects, or creators;
No Find command, and;
No AppleScript support.

Conclusion
When I say that NetNewsWire has changed the way I view the Web, I’m not exaggerating.
I subscribe to more than sixty Web sites right now, most of which I’d never heard of prior
to using NetNewsWire. Not only that, but there’s no way I could remember all of those
links. Now, I just start up NetNewsWire when I boot my computer and let the information
come to me.
Copyright © 2003 Eric Blair, eblair@atpm.com. Reviewing in ATPM is open to anyone. If you’re
interested, write to us at reviews@atpm.com.
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Review: Photo Mechanic 3
by Gregory Tetrault, gtetrault@atpm.com

Developer: Camera Bits
Price: $150
Requirements: PowerPC-based Mac with Mac OS 8.6 or Mac OS X 10.1, CarbonLib 1.3.1,
QuickTime 3, 20 MB of application RAM, 800x600 resolution. Card reader with
software that can mount a card on the desktop.
Recommended: Mac OS 9 users should give Photo Mechanic more application RAM to
improve image display speed.
Trial: None

Overview
Photo Mechanic is an image-browsing and information-editing application. It is designed
to import digital images and their associated information from card readers and from
computer files. Photo Mechanic contains many image-related data and information fields,
including all IPTC fields and Global Positioning System values. What is unique about Photo
Mechanic is that it does not create separate catalog files. Instead, it adds a “cbtn”
resource to each image file.

Installation
An Installer VISE file is on the CD or can be downloaded from the Camera Bits Web site.
The installer lets you choose the location for the Photo Mechanic folder. When you first
launch Photo Mechanic, you must enter your registration information.

Using Photo Mechanic
Photo Mechanic is designed primarily to work with card readers that allow Compact Flash
Cards, Memory Sticks, Secure Digital Multimedia Cards, or SmartMedia Cards to be
mounted on the desktop. Images can be imported directly from compatible cards for
loading into Photo Mechanic catalogs and (optionally) storage on a hard drive. You create
a catalog by selecting either Open Contact Sheet… or Ingest Disks… from the File menu.
Open Contact Sheet… should be renamed Create Contact Sheet, since that is its function.
You use the resulting Open dialog box to select a disk or folder containing images you
wish to catalog.
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Ingest Disks… lets you import all the photographs from a card reader or any drive
connected via FireWire or USB. The resulting catalog window (Contact Sheet in Photo
Mechanic’s terminology) takes up most of the screen. Each photo is assigned a block that
is approximately 210 pixels high and 180 to 200 pixels wide. You have no control over the
layout of the contact sheet.

Ingest Disks Options
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Catalog Window

Photo Mechanic supports most high-end digital cameras, meaning that it can work with
RAW image files, generate low-resolution previews, and capture EXIF information.
You can add and edit text information for images individually or in batches. Photo
Mechanic supports IPTC tags, GPS, and EXIF information fields. Photo Mechanic’s IPTC
Stationery Pad lets you create lists of choices for most of the fields so that data can be
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entered via pop-up menus. You can also load IPT files into the IPTC Stationery Pad. This
allows workgroups to have identical labeling information. EXIF information is edited or
added via a small window in the upper right corner of the image editing window.

IPTC Information Editing Screen
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Image Editing Window with EXIF Information Fields

Photo Mechanic has only a few image manipulation tools. You can rotate the image in 90degree increments using the rotate arrows or Rotate menu items (in the Image menu). You
can also crop the image. Rotation and cropping changes are not saved unless you choose
Save Photos as JPEGs… from the File menu. Photo Mechanic includes an Edit Image item
in the Image menu. This opens the selected image in Adobe Photoshop or Photoshop LE
for advanced editing. Double-clicking on an image or its thumbnail also opens it in
Photoshop.
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Photo Mechanic has tools for sequentially labeling images. This allows you to select and
sort images based on whatever criterion you prefer, and then name them sequentially.

Options for saving images with sequential labels.
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Photo Mechanic can play slide shows of selected images. Slide show options are limited
compared with other applications. Options include playing attached sounds, showing
cropped images, and selecting the delay time between images. Slide shows cannot be
saved.

Setting-up a slide show.
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Photo Mechanic can export images as HTML or XML files.

Options for exporting images as HTML pages.
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Photo Mechanic creates a thumbnail image page (you select thumbnail size) and individual
pages for each image (you set the image dimensions and JPEG quality). Photo Mechanic
creates individual JPEG files for each thumbnail and image. Each image page gets its own
HTML file containing an image placeholder, navigation controls, and text information (you
choose which fields) for its respective image.

Thumbnail image HTML page.
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Individual image HTML page.

Photo Mechanic lets you print contact sheets. However, its layout options are limited to
equal numbers of columns and rows (for example, a 4x3 layout is not allowed). You can
adjust the margins and the spacing between images, and you can choose what
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information will appear in the headers, footers, and image captions. However, you cannot
choose the font or font size of any of the text information. The heading is Geneva bold at
14 point and the remaining text is Geneva at 9 point.

Options for printing contact sheets

Problems and Bugs
I encountered no problems or bugs while testing Photo Mechanic.

Omissions
• You cannot import images directly from digital cameras.
• The main window is not resizable, and you cannot modify the on-screen layout of
contact sheets.
• There is no way to change the image-editing application from Photoshop to
something else.
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Documentation
The application comes with a nine-page (8.5" x 11") PDF Read Me file and a 34-page
Photo Mechanic 3.0 User’s Guide. The User’s Guide has bookmarks and a hyperlinked
table of contents. It has no index. The User’s Guide and Read Me documents, in
combination, fully describe the use of Photo Mechanic. However, a revised, unified User’s
Guide incorporating the additions and changes of the current version would be welcome.

Technical Support
E-mail support is available. There is no online support. Telephone support may be available
at the main toll number, but I did not check this. I also did not test the rapidity or accuracy
of e-mail support.

Alternatives
• iView MediaPro ($90)
• QPict ($35)
• Image Viewer 6.1.2 ($35)

Summary
Photo Mechanic performs as advertised. However, it is an expensive application with a
limited feature set. I prefer iView MediaPro: it is more flexible and powerful than Photo
Mechanic (it lacks only pre-built fields for GPS data) and costs $60 less.
Copyright © 2003 Gregory Tetrault, gtetrault@atpm.com. Reviewing in ATPM is open to anyone. If
you’re interested, write to us at reviews@atpm.com.
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Review: Secrets of the iPod, 2nd Edition (book)
by Kirk McElhearn, kmcelhearn@atpm.com

Author: Christopher Breen; published by Peachpit Press.
Price: $21.99
Trial: None

Oh, I wish I had an iPod. Well, not really. You see, while the geek in me
wants one for the tech toy it is, I don’t have much use for it. I work at
home, and my only commute is from the first floor of my house to the second floor. That’s
about 18 seconds, so an iPod wouldn’t serve much purpose.
But I understand why so many people have bought them, and why they are so attached to
them. Reading Christopher Breen’s Secrets of the iPod really tempts me, if only to discover
all the neat things he presents in the book.
Breen goes through every nook and cranny of the iPod—the hardware, the software, and
a whole slew of accessories. Anyone who uses an iPod will certainly discover some things
they didn’t know as Breen gives tips and tricks for getting the most out of the device. He
naturally talks about copying music to the iPod, but also shows you how you can copy
contact information, calendars, and more, using it as a poor man’s PDA.
The iPod is the natural extension to Apple’s iTunes, and Breen goes over everything you
need to know to use the two of them together. He also shows how to use available
Windows software for the iPod, so that PC users aren’t left out in the cold.
But the iPod does much more. Sure, it plays music, that’s the main reason for having one.
But you can also download audio books. It can be a portable FireWire hard drive. And by
using a program to clone your Mac OS X startup volume, you can even use it to boot in OS
X. It’s great as a backup device, if you have room after putting a few days’ worth of music
on it.
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I generally shy away from books devoted to just one hardware device, but I can see that
iPod users would really benefit from this book. It’s concise and to the point, and Breen’s
no-nonsense writing helps iPod owners do everything possible with their device. This book
is an excellent way to learn everything about your iPod, and enjoy it as well.
Copyright © 2003 Kirk McElhearn, kmcelhearn@atpm.com. Reviewing in ATPM is open to anyone.
If you’re interested, write to us at reviews@atpm.com.
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Review: Studio MX
by Lee Bennett and Darryl Barney, lbennett@atpm.com

Developer: Macromedia
Price: $899; $499–699 (upgrade, see Macromedia’s Web site)
Requirements: G3-based Mac with Mac OS 9.1 (with MRJ 2.2 and CarbonLib 1.3) or Mac
OS X 10.1, 96 MB application RAM, 16-bit color, 1024x768 resolution, 510 MB
available disk space.
Recommended: 128 MB application RAM
Trial: Fully-featured (30 days)

Studio MX is Macromedia’s new bundle of its popular animation, vector graphics, and
Web development software, combining Flash, FreeHand, Dreamweaver, and Fireworks.
The MX package also represents version upgrades for all of these tools, although the
review copy we received still included FreeHand 10. Purchasing Studio MX now will
include FreeHand MX (version 11) according to the Macromedia Web site. The new
version’s features are listed near the end of this review.
The key feature of Studio MX is the interoperability among the applications. This enables a
user to effortlessly manipulate a project with any of Studio MX’s tools. The seamless
transfer capability provides the benefits of an all-inclusive single application without
becoming a bloated, one-size-fits-all application (ahem, Netscape).
According to the Studio MX manual, each Studio MX application provides “a common
interface and default location for the Tools panel so that you can seamlessly work with
tools, color palettes, and other features to build images and move them across the
products.”
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Dreamweaver
Dreamweaver is Macromedia’s premiere Web content editing tool. It supports
development in HTML, XHTML, XML, ASP, ASP.NET, JSP, PHP, and Macromedia’s own
ColdFusion. Included with Studio MX, ColdFusion is a scripting environment to build
dynamic Internet applications with aided integration with other Web-based development
platforms.

Whether you prefer raw HTML editing, WYSIWYG editing, or both, Dreamweaver caters to
individual taste.
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Web developers can choose the style of editing they prefer, as Dreamweaver works as
both an HTML code editor and a WYSIWYG (What You See Is What You Get) editor. Both
modes can be used interchangeably with a common, drag-and-drop toolbar to add the
desired functions to the Web page.

Dreamweaver makes creating elements as
uncomplicated as possible by letting you
work visually and by code, simultaneously.
This example shows the steps to create a
table. First, click the Insert Table button from
the toolbar.

Define initial values for the table’s look.
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Fine-tune the table’s look either by changing attribute values in HTML view,
or by stretching the table’s sides and corners in WYSIWYG view.
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Adding cell content in one view automatically updates the other view.
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To join cells into a rowspan or colspan, first select the
cells to be joined. An entire row or column can be
quick-selected, as shown.

Click the merge button under the Column section in the Properties palette.

ATPM 9.04

97

Review: Studio MX

Your cells are now merged and you can add content as normal.
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Another major feature of Dreamweaver is site management. With just a few clicks,
developers can upload and maintain their Web site files and modify any element of a Web
document with ease.

Built-in site management helps keep your remote site synchronized with your local files and
can display your site in a hierarchical tree format.
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One of the most unique options in Dreamweaver is the integration with its supported
coding languages. No matter which language you use, your work will be color-coded and
numbered. Basic templates are included for all languages, allowing you to drag-and-drop
objects from multiple scripting languages into a Web page.

Separate color coding schemes visually identify each programming language
used in a document. Every scheme is customizable.

Flash
Flash is used to create multimedia and user interfaces for the Web. The files that are
created are generally very small in size, permitting even dialup viewers to experience
design without huge wait times. This is accomplished by the use of vector-based graphics.
Bitmapped images can also be used in Flash documents that are also optimized for speed.
Web site graphics were essentially based only on bitmapped images until Macromedia
Flash became one of the first successful implementations of vector-based graphics on the
Web.
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The free Flash Player plug-in is installed by default in nearly all current Web browsers, and
is easily downloaded and installed in most other browsers. This large user base makes
Flash an attractive option to create visually rich and bandwidth-friendly presentations of
Web-based information.
With the included tutorials and samples, you’ll be animating in minutes. Flash uses a very
intuitive menu system to provide access to everything you need for your project. If you’re
already comfortable with using time-line-based editing for video in such applications as
iMovie or Final Cut Pro, you should be right at home in Flash.

Create your Flash animation using objects and functions from easily-accessible menus
surrounding your stage area.
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One of Flash’s most often used functions is Motion Tweening to animate an object. The
following screen shots demonstrate how to create a simple animation:

Step 1: Convert a selected graphic into a symbol with the Convert to Symbol
command in the Insert menu and set the Behavior to Graphic.
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Step 2: In the Timeline, select the frame that will be the last frame of the
animation and select Keyframe from the Insert menu. The clip’s length will be
indicated as a light gray bar in the Timeline.
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Step 3: Click the first frame of the animation and select Create Motion Tween
from the Insert menu. The clip will change color to blue with a dashed line,
indicating that the object has been attached to the keyframe you defined in
Step 2.
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Step 4: Click back to the last frame of the animation (the keyframe). With the
pointer tool, drag the object to the desired ending location of its animation.
To move the object in a straight line (45-degree increments), hold the Shift
key while dragging.
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Step 5: Test your animation by pressing the Return key. This snapshot has the
Onion Skin option enabled (the darkened button at the bottom of the time
line) which displays a range of steps of your final animation. The range can be
changed by dragging the left and right sides of the darkened area at the top
of the time line.

Your objects aren’t limited to moving in a straight line. Objects can also be animated to
follow a nonlinear path as well as change color, size, rotation, etc. as it progresses along
the time line.
A new feature in Flash MX is the close integration with Components (see bottom right of
the above illustration). Components are objects such as check boxes, drop down lists,
submit buttons, and text fields. These allow easy creation of oft-used interfaces in the
Flash document.
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Third-party applications such as Swift 3D allow Flash to handle three-dimensional input
and create even more visually rich designs.

Fireworks
Popular for creating rollover and pop-up navigation effects for Web pages, Fireworks
includes tools for building vector or bitmapped graphics, layering interactive effects, then
integrating the finished effect into a Dreamweaver or Flash project. The built-in styles help
you quickly create interactive menus without any knowledge of the scripting languages
required to make them.
You can start by using templates to create navigation buttons, or by importing your own
graphics created in another image editing application.
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To create an effect, simply follow the instructions of the step-by-step interface which will
guide you through the process of creating a rollover and/or pop-up menu.

Step 1: Define menu items in the order you want them to appear, along with
corresponding links and, if required, targets. Use the provided buttons to set
up nested, hierarchal menus.
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Step 2: Customize the menu’s look by choosing HTML-created or imagecreated buttons. Image-created buttons provide a selection of bevels and
background textures to choose from.
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Step 3: Fine-tune the look of your menu by adjusting the size, padding, and
spacing of each button (cell), how far to indent text from the edge of the cell,
how long the menu should remain visible after the mouse pointer has moved
away, and settings for borders around the menu.
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Step 4: Finally, define where the menu should appear. Four preset buttons are
provided for common menu positions plus three default submenu positions.
X and Y values let you make fine adjustments.

FreeHand
FreeHand was originally positioned as a vector-based illustration package intended for
creating graphics for desktop publishing projects. Today, its capabilities reach far beyond
the print industry. ATPM previously reviewed FreeHand 10 in the July 2001 issue and, like
Studio MX, gave it an Excellent rating.
“FreeHand has outgrown its category so much that it would be unfair to compare
it to [Adobe] Illustrator.” —Jamal Ghandour
As previously mentioned, the review copy of Studio MX was sent with FreeHand 10. A
page on Macromedia’s Web site lists the top 10 new features of FreeHand MX as:
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1. Unlimited stroke, fill, and effect attributes to a single vector or text object.
2. New Object Panel providing stacking control of multiple attributes.
3. Live Effects apply distortions and effects without altering the original object.
4. Ability to reshape rectangles, ellipses, and polygons while maintaining control and
editability of graphic primitives.
5. An updated workspace designed to integrate with other Studio MX products.
6. Flash MX integration.
7. Action Tool enabling drag and drop of Flash MX actions among objects, symbols, and
pages.
8. Connector Lines Tool to quickly map information architecture, data flows, and site
maps.
9. Additional new or enhanced creative tools including Extrude, Blend, and Eraser, plus
alpha channel support for imported bitmaps.
10.Fireworks MX integration.

Conclusion
In reviewing Studio MX, we felt the most important aspect that merits praise was not the
exceptional capabilities of any one of the applications, which can be purchased
individually. Rather, at $899, Macromedia is wisely offering the products as a single,
reduced-cost package (saving about $700). Purchasing comparable Adobe products
would total at least $1,200. Adobe’s Web Collection package is a $999 alternative that
also includes Photoshop and Acrobat, but not LiveMotion—Adobe’s answer to Flash.
Indeed, LiveMotion projects are typically finished as QuickTime or Flash files! Also, the
Web Collection package is simply a bundle of the included Adobe products. While Adobe
has been singing about the integration between the latest versions, we feel Studio MX’s
integration is superior, practically making it a must-have for the Web developer looking to
have support for the widest array of coding languages.
Copyright © 2003 Lee Bennett and Darryl Barney, lbennett@atpm.com and darrylb@darrylb.net.
Reviewing in ATPM is open to anyone. If you’re interested, write to us at reviews@atpm.com.
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Frequently Asked Questions

FAQ: Frequently Asked Questions
What Is ATPM?
About This Particular Macintosh (ATPM) is, among other things, a monthly Internet
magazine or “e-zine.” ATPM was created to celebrate the personal computing
experience. For us this means the most personal of all personal computers—the Apple
Macintosh. About This Particular Macintosh is intended to be about your Macintosh, our
Macintoshes, and the creative, personal ideas and experiences of everyone who uses a
Mac. We hope that we will continue to be faithful to our mission.

Are You Looking for New Staff Members?
We currently need several Contributing Editors. Please contact us if you’re interested.

How Can I Subscribe to ATPM?
Visit the subscriptions page.

Which Format Is Best for Me?
The Online Webzine edition is for people who want to view ATPM in their Web
browser, while connected to the Internet. It provides sharp text, lots of navigation
options, and live links to ATPM back issues and other Web pages. You can use
Sherlock to search all of the online issues at once.
The Offline Webzine is a HTML version of ATPM that is formatted for viewing
offline and made available in a StuffIt archive to reduce file size. The graphics,
content, and navigation elements are the same as with the Online Webzine, but
you can view it without being connected to the Internet. It requires a Web browser.
The Print PDF edition is saved in Adobe Acrobat format. It has a two-column
layout with smaller text and higher-resolution graphics that are optimized for
printing. It may be viewed online in a browser, or downloaded and viewed in
Adobe’s free Acrobat Reader on Macintosh or Windows. PDFs may be magnified to any
size and searched with ease.
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The Screen PDF edition is also saved in Adobe Acrobat format. It’s a one-column
layout with larger text that’s optimized for reading on-screen. It may be viewed
online in a browser, or downloaded and viewed in Adobe’s free Acrobat Reader on
Macintosh or Windows. PDFs may be magnified to any size and searched with ease.

What Are Some Tips for Viewing PDFs?
• You can download Adobe Acrobat Reader for free. If you have a Power Macintosh,
Acrobat Reader 5 has better quality and performance. ATPM is also compatible with
Acrobat Reader 3, for those with 680x0 Macs.
• You can zoom the PDF to full window width and scroll through articles simply by
single-clicking anywhere in the article text (except underlined links).
• You can quickly navigate between articles using the bookmarks pane at the left of
the main viewing window.
• For best results on small screens, be sure to hide the bookmarks pane; that way you’ll
be able to see the entire page width at 100%.
• Try turning Font Smoothing on and off in Acrobat Reader’s preferences to see which
setting you prefer.
• All blue-underlined links are clickable.
• You can hold down option while hovering over a link to see where it will lead.
• For best results, turn off Acrobat’s “Fit to Page” option before printing.

Why Are Some Links Double-Underlined?
In the PDF editions of ATPM, links that are double-underlined lead to other pages in the
same PDF. Links that are single-underlined will open in your Web browser.

What If I Get Errors Decoding ATPM?
ATPM and MacFixIt readers have reported problems decoding MacBinary files using early
versions of StuffIt Expander 5.x. If you encounter problems decoding ATPM, we
recommend upgrading to StuffIt Expander 5.1.4 or later.

How Can I Submit Cover Art?
We enjoy the opportunity to display new, original cover art every month. We’re also very
proud of the people who have come forward to offer us cover art for each issue. If you’re
a Macintosh artist and interested in preparing a cover for ATPM, please e-mail us. The way
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the process works is pretty simple. As soon as we have a topic or theme for the upcoming
issue we let you know about it. Then, it’s up to you. We do not pay for cover art but we
are an international publication with a broad readership and we give appropriate credit
alongside your work. There’s space for an e-mail address and a Web page URL, too. Write
to editor@atpm.com for more information.

How Can I Send a Letter to the Editor?
Got a comment about an article that you read in ATPM? Is there something you’d like us
to write about in a future issue? We’d love to hear from you. Send your e-mail to
editor@atpm.com. We often publish the e-mail that comes our way.

Do You Answer Technical Support Questions?
Of course. E-mail our Help Department at help@atpm.com.

How Can I Contribute to ATPM?
There are several sections of ATPM to which readers frequently contribute:
Segments: Slices from the Macintosh Life

This is one of our most successful spaces and one of our favorite places. We think of it as
kind of the ATPM “guest room.” This is where we will publish that sentimental Macintosh
story that you promised yourself you would one day write. It’s that special place in ATPM
that’s specifically designated for your stories. We’d really like to hear from you. Several
Segments contributors have gone on to become ATPM columnists. Send your stuff to
editor@atpm.com.
Hardware and Software Reviews

ATPM publishes hardware and software reviews. However, we do things in a rather
unique way. Techno-jargon can be useful to engineers but is not always a help to most
Mac users. We like reviews that inform our readers about how a particular piece of
hardware or software will help their Macintosh lives. We want them to know what works,
how it may help them in their work, and how enthusiastic they are about recommending
it to others. If you have a new piece of hardware or software that you’d like to review,
contact our reviews editor at reviews@atpm.com for more information.
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Shareware Reviews

Most of us have been there; we find that special piece of shareware that significantly
improves the quality our Macintosh life and we wonder why the entire world hasn’t heard
about it. Now here’s the chance to tell them! Simply let us know by writing up a short
review for our shareware section. Send your reviews to reviews@atpm.com.

Which Products Have You Reviewed?
Check our reviews index for the complete list.

What is Your Rating Scale?
ATPM uses the following ratings (in order from best to worst): Excellent, Very Nice, Good,
Okay, Rotten.

Will You Review My Product?
If you or your company has a product that you’d like to see reviewed, send a copy our
way. We’re always looking for interesting pieces of software to try out. Contact
reviews@atpm.com for shipping information. You can send press releases to
news@atpm.com.

Can I Sponsor ATPM?
About This Particular Macintosh is free, and we intend to keep it this way. Our editors and
staff are volunteers with “real” jobs who believe in the Macintosh way of computing. We
don’t make a profit, nor do we plan to. As such, we rely on advertisers to help us pay for
our Web site and other expenses. Please consider supporting ATPM by advertising in our
issues and on our web site. Contact advertise@atpm.com for more information.

Where Can I Find Back Issues of ATPM?
Back issues of ATPM, dating since April 1995, are available in DOCMaker stand-alone
format. In addition, all issues since ATPM 2.05 (May 1996) are available in HTML format.
You can search all of our back issues.
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What If My Question Isn’t Answered Above?
We hope by now that you’ve found what you’re looking for (We can’t imagine there’s
something else about ATPM that you’d like to know.). But just in case you’ve read this far
(We appreciate your tenacity.) and still haven’t found that little piece of information about
ATPM that you came here to find, please feel free to e-mail us at (You guessed it.)
editor@atpm.com.
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